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About Micriµm 

Micriµm provides high-quality embedded software components in the industry by way of engineer-friendly 
source code, unsurpassed documentation, and customer support. The company‟s world-renowned real-

time operating system, the Micriµm µC/OS-II, features the highest-quality source code available for 

today's embedded market. Micriµm delivers to the embedded marketplace a full portfolio of embedded 

software components that complement µC/OS-II. A TCP/IP stack, USB stack, CAN stack, File System 

(FS), Graphical User Interface (GUI), as well as many other high quality embedded components. 
Micriµm‟s products consistently shorten time-to-market throughout all product development cycles. For 
additional information on Micriµm, please visit www.micrium.com. 

About µC/OS-II  

µC/OS-II is a preemptive, real-time, multitasking kernel.  µC/OS-II has been ported to over 45 different 

CPU architectures. 

µC/OS-II is small yet provides all the services you‟d expect from an RTOS: task management, time and 

timer management, semaphore and mutex, message mailboxes and queues, event flags an much more. 

You will find that µC/OS-II delivers on all your expectations and you will be pleased by its ease of use. 

Licensing 

µC/OS-II is provided in source form for FREE evaluation, for educational use or for peaceful research.  If 

you plan on using µC/OS-II in a commercial product you need to contact Micriµm to properly license its 

use in your product.  We provide ALL the source code with this application note for your convenience and 

to help you experience µC/OS-II.  The fact that the source is provided DOES NOT mean that you can 

use it without paying a licensing fee.  Please help us continue to provide the Embedded community with 
the finest software available.  Your honesty is greatly appreciated. 

http://www.micrium.com/
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About µC/Probe Demo Version 

μC/Probe is a Windows application that allows a user to display and change the value (at run-time) of 

virtually any variable or memory location on a connected embedded target. The user simply populates 

μC/Probe‟s graphical environment with gauges, tables, graphs, and other components, and associates 

each of these with a variable or memory location. Once the application is loaded onto the target, the user 

can begin μC/Probe‟s data collection, which will update the screen with variable values fetched from the 

target.  
 

μC/Probe retrieves the values of global variables from a connected embedded target and displays the 

values in an engineer-friendly format.  The supported data-types are: booleans, integers, floats and ASCII 
strings. 
 

μC/Probe can have any number of „data screens‟ where these variables are displayed. This allows to 

logically grouping different „views‟ into a product. 
 

This μC/Probe demo version can only retrieve information from RS-232C or J-LINK interfaces and is 

limited up to 15 symbols. 

  

The demo version of μC/Probe is available on the Micriµm website: 

 

   http://www.micrium.com/products/probe/probe.html 
 

About µC/Probe Full Version 

The full version of μC/Probe allows you to use a TCP/IP is a Windows application that allows a user to 

display and change the value (at run-time) of virtually any variable or memory location on a connected 

embedded target. The user simply populates μC/Probe‟s graphical environment with gauges, tables, 

graphs, and other components, and associates each of these with a variable or memory location. Once 

the application is loaded onto the target, the user can begin μC/Probe‟s data collection, which will update 

the screen with variable values fetched from the target.  

http://www.micrium.com/products/probe/probe.html
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Manual Version 

If you find any errors in this document, please inform us and we will make the appropriate corrections for 
future releases. 

Version Date By Description 

V 1.00 2008/19/19 FT Initial revision. 

 

Software Versions 

This document may or may not have been downloaded as part of an executable file, Micrium-NXP-uCOS-

II-LPC2103-02-SK.exe containing the code and projects described here.  If so, then the versions of the 
Micriµm software modules in the table below would be included.  In either case, the software port 
described in this document uses the module versions in the table below   

Module Version Comment 

μC/OS-II V2.86  

μC/Probe V2.20  
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Document Conventions 

Numbers and Number Bases 

 Hexadecimal numbers are preceded by the “0x” prefix and displayed in a monospaced font.  
Example: 0xFF886633. 

 Binary numbers are followed by the suffix “b”; for longer numbers, groups of four digits are 
separated with a space.  These are also displayed in a monospaced font.  Example: 0101 1010 

0011 1100b.  

 Other numbers in the document are decimal.  These are displayed in the proportional font 
prevailing where the number is used. 

Typographical Conventions 

 Hexadecimal and binary numbers are displayed in a monospaced font. 

 Code excerpts, variable names, and function names are displayed in a monospaced font.  
Functions names are always followed by empty parentheses (e.g., OS_Start()).  Array names 

are always followed by empty square brackets (e.g., BSP_Vector_Array[]). 

 File and directory names are always displayed in an italicized serif font.  Example: 
/Micrium/Sofware/uCOS-II/Source/. 

 A bold style may be layered on any of the preceding conventions—or in ordinary text—to more 
strongly emphasize a particular detail.  

 Any other text is displayed in a sans-serif font. 
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1.  Introduction 

This document, AN-1074, explains example code for using µC/OS-II and µC/Probe with the NXP 

LPC2103 processor on the IAR LPC2103-02-SK evaluation board, shown in Figure 1.   

The LPC2103 microcontroller is based on a 16-bit/32-bit ARM7TDMI-S CPU with real-time emulation that 
combines the microcontroller with 32 kB of embedded high speed flash memory.  A blend of serial 
communications interfaces, ranging from multiple UARTS, SPI, and SSP to two I2Cs, and on-chip SRAM 
of 8 kB make these devices very well suited for communication gateways and protocol converters. 

The IAR LPC2103-02-SK board includes : 

  
• NXP LPC2103 MCU 
• J-LINK on-chip with USB cable 
• One serial port 
• Reset button 
• In-system programming (ISP) button 
• Two user-defined buttons 
• 16 fully configurable LEDs 
• Power-on LED 
• Lithium back-up battery and holder 
• Breakout headers for all pins (suitable for mounting daughter boards) 
• Small array of plated holes for prototyping 

 

 

 
 
 

Figure 1-1.  IAR LCP2103-02-SK 

J-LINK on-chip with 

USB Cabe 

RS-232  

(for µC/Probe) 

Push Buttons 

LEDs 

Potentiometer 
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If this appnote was downloaded in a packaged executable zip file, then it should have been found in the 
directory /Micrium/Appnotes/AN1xxx-RTOS/AN1074-uCOS-II-NXP-LPC2103-02-SK and the code files 
referred to herein are located in the directory structure displayed in Section 2.02; these files are described 
in Section 3. 

The executable zip also includes example workspaces for µC/Probe.  µC/Probe is a Windows program 

which retrieves the value of variables form a connected embedded target and displays the values in an 
engineer-friendly format as shown in Figure 1-2.  It interfaces with the IAR LPC2103-02-SK via RS-232C.  
For more information, including instructions for downloading a trial and the demo version of the program, 
please refer to   Section 6. 

 
 

Figure 1-2.  µC/Probe (with Target Output Window) 
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2.  Getting Started 

The following sections step through the prerequisites for using the demonstration application described in 
this document, AN-1074  First, the setup of the hardware will be outlined.  Second, the use and setup of 
the IAR Embedded Workbench project will be described.  Thirdly, the steps to build the projects and load 
the application onto the board through a JTAG will be described.  Lastly, instructions will be provided for 
using the example application. 

2.01  Setting up the Hardware 

The evaluation board can only be  powered through the USB connector on the board.  The processor on 
the evaluation board can be programmed and debugged through the USB J-LINK port. 

To use µC/Probe with the IAR-LPC2103-02-SK, download and install the trial version of the program 

from the Micriµm website as discussed in Section 6.  After programming your target with one of the 
included example projects, connect a RS-232 cable between your PC and the evaluation board, configure 
the RS-232 options (also covered in Section 6), and start running the program.  The open data screens 
should update.  The IAR LPC2103-02-SK example application is configured to use UART0, the RS-232C 

connector labeled “RS-232 for µC/Probe” in Figure 1-1. 

2.02  Directory Tree 

If this file were downloaded as part of an executable zip file (which should have been named              
Micrium-NXP-uCOS-II-LPC2103-02-SK.exe, then the code files referred to herein are located in the directory 
structure shown in Figure 2-2.   
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\Micrium 

    \AppNotes 

        \AN1xxx-RTOS 

            \AN1014-uCOS-II-ARM 

            \AN1074-uCOS-II-NXP-LPC2103-02-SK 

 

         \AN9xxx-MULT 

            \AN9913-IAR-Probe-Demo 

 

    \Licensing 

 

    \Software 

        \EvalBoards 

            \<NXP> 

                \LPC2103-02-SK 

                    \IAR 

                        \BSP                             

                        \OS-Probe 

 

        \uC-CPU 

            \ARM 

                \IAR 

        \uC-LIB 

 

        \uCOS-II 

            \Doc 

            \Ports 

                \ARM 

                    \Generic 

                        \IAR 

            \Source 

 

        \uC-Probe 

            \Target 

                \Communication 

                    \DCC 

                    \Generic 

                        \OS 

                            \uCOS-II 

                        \RS-232 

                            \OS 

                                \uCOS-II 

                            \Ports 

                                \NXP 

                                    \LPC21xx 

                            \Source 

                        \Source                 

                 \KSD 

                     \Source 

                     \Workspace 

                 \Plugins 

                     \uCOS-II 

 

 

Figure 2-1. Directory Structure 
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http://www.micrium.com/
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2.03  Using the IAR Projects 

One IAR project is located in the directory marked “IAR Example Project ” in Figure 2-1: 

/Micrium/Software/EvalBoards/NXP/LPC2103-02-SK/IAR/OS-Probe 

The example project, LPC2103-02-SK-OS-Probe-v5-2.ewp, is intended for EWARM v5.2x.  To view this 
example, start an instance of IAR EWARM v5.2x, and open the workspace file                                 
LPC2103-02-SK-OS-Probe-v5-2.eww.  To do this, select the “Open” menu command under the “File” menu, 
select the “Workspace…” submenu command and select the workspace file after navigating to the project 
directory.  The project tree shown in Figure 2-2 should appear.  (In addition, the workspace should be 
openable by double-clicking on the file itself in a Windows Explorer window.) 

2.03.01 µC/OS-II Kernel Awareness  

When running the IAR C-Spy debugger, the μC/OS-II Kernel Awareness Plug-In can be used to provide 

useful information about the status of μC/OS-II objects and tasks.  If the μC/OS-II Kernel Awareness 

Plug-In is currently enabled, then a “μC/OS-II” menu should be displayed while debugging.  Otherwise, the 
plug-in can be enabled.  Stop the debugger (if it is currently active) and select the “Options” menu item 
from the “Project” menu.  Select the “Debugger” entry in the list box and then select the “Plugins” tab 

pane.  Find the μC/OS-II entry in the list and select the check box beside the entry, as shown in        

Figure 2-4.   

When the code is reloaded onto the evaluation board, the “μC/OS-II” menu should appear.  Options are 
included to display lists of kernel objects such as semaphores, queues, and mailboxes, including for each 
entry the state of the object.  Additionally, a list of the current tasks may be displayed, including for each 
task pertinent information such as used stack space, task status, and task priority, in addition to showing 
the actively executing task.  An example task list for this project is shown in Figure 2-5. 

 

 

Figure 2-4. Enabling the μC/OS-II Kernel Awareness Plug-In 
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Figure 2-5. µC/OS-II Task List. 

2.04  Example Applications 

The example projects include a basic demonstration of the µC/OS-II and µC/Probe.  After you load the 

evaluation board the sample project, the LEDs will start blinkging  
 

 

Stack Out of Range Notification 

While debugging this project (or any other μC/OS-II project), IAR may log a SVC stack 

pointer out-of-range notification in the “Debug Log” window.  This is actually normal 

behavior and does NOT indicate an error.  IAR EWARM does not understand that the 
SVC stack pointer points to the stack for the current task stack. 
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3.  Directories and Files  

Application Notes 

/Micrium/AppNotes/AN1xxx-RTOS\AN1014-uCOS-II-ARM 

This directory contains AN-1014.pdf, the application note describing the ARM port for μC/OS-II, 

and AN-1014-PPT.pdf, a supplement to AN-1014.pdf.  

\Micrium\AppNotes\AN1xxx-RTOS\AN1074-uCOS-II-NXP-LPC2103-02-SK 

This directory contains this application note, AN-1074pdf. 

\Micrium\AppNotes\AN9xxx-MULT\AN-9913-IAR-Probe-Demo 

This directory contains this application note, AN-9913.pdf. 

Licensing Information 

\Micrium\Licensing 

Licensing agreements are located in this directory.  Any source code accompanying this appnote 

is provided for evaluation purposes only.  If you choose to use μC/OS-II in a commercial product, 

you must contact Micriμm regarding the necessary licensing. 

 

μC/OS-II Files 

\Micrium\Software\uCOS-II\Doc 

This directory contains documentation for μC/OS-II. 

\Micrium\Software\uCOS-II\Ports\ARM\Generic\IAR 

This directory contains the standard processor-specific files for the generic μC/OS-II ARM port 

assuming the IAR toolchain.  These files could easily be modified to work with other toolchains 
(i.e., compiler/assembler/linker/locator/debugger); however, the modified files should be placed 
into a different directory.  The following files are in this directory: 

 os_cpu.h 

 os_cpu_a.asm 

 os_cpu_c.c 

 os_dcc.c 

 os_dbg.c 

With this port, μC/OS-II can be used in either ARM or Thumb mode.  Thumb mode, which 

drastically reduces the size of the code, was used in this example, but compiler settings may be 
switched (as discussed in Section 2.30) to generate ARM-mode code without needing to change 
either the port or the application code.  The ARM/Thumb port is described in application note AN-

1014 which is available from the Micrium web site. 

\Micrium\Software\uCOS-II\Source 

This directory contains the processor-independent source code for μC/OS-II. 
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μC/Probe Files 

\Micrium\Software\uC-Probe\Communication\Generic\ 

This directory contains the μC/Probe generic communication module, the target-side code 

responsible for responding to requests from the μC/Probe Windows application (including 

requests over RS-232). 

\Micrium\Software\uC-Probe\Communication\Generic\Source 

This directory contains probe_com.c and probe_com.h, the source code for the generic 
communication module. 

\Micrium\Software\uC-Probe\Communication\Generic\OS\uCOS-II 

This directory contains probe_com_os.c, which is the μC/OS-II port for the μC/Probe generic 

communication module. 

\Micrium\Software\uC-Probe\Communication\Generic\Source\RS-232 

This directory contains the RS-232 specific code for μC/Probe generic communication module, 

the target-side code responsible for responding to requests from the μC/Probe Windows 

application over RS-232 

\Micrium\Software\uC-Probe\Communication\Generic\Source\RS-232\Source 

This directory contains probe_rs232.c and probe_rs232.h, the source code for the generic 
communication module RS-232 code. 

\Micrium\Software\uC-Probe\Communication\Generic\Source\RS-232\Ports\NXP\LPC21xx 

This directory contains probe_rs232c.c and probe_rs232c.h, the LPC21xx port for the RS-232 
communications. 

\Micrium\Software\uC-Probe\Communication\Generic\Source\RS-232\OS\uCOS-II 

This directory contains probe_rs232_os.c, which is the μC/OS-II port for the μC/Probe RS-232 

communication module. 

\Micrium\Software\uC-Probe\Target\Demo\KSD\Source 

This directory contains ksd.c and ksd.h, the source code for the IAR Kickstart kits demo example 

for the demo version of μC/Probe. 

\Micrium\Software\uC-Probe\Target\Demo\KSD\Workspace 

This directory contains OS-Probe-Kickstart-Demo-Workspace.wsp which is the generic μC/Probe 

workspace for the IAR Kickstart kits. 
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μC/CPU Files 

\Micrium\Software\uC-CPU 

This directory contains cpu_def.h, which declares #define constants for CPU alignment, 

endianness, and other generic CPU properties. 

 

\Micrium\Software\uC-CPU\ARM\IAR 

This directory contains cpu.h and cpu_a.s.  cpu.h defines the Micriμm portable data types for 8-, 
16-, and 32-bit signed and unsigned integers (such as CPU_INT16U, a 16-bit unsigned integer).  

These allow code to be independent of processor and compiler word size definitions.  cpu_a.s 
contains generic assembly code for ARM7 and ARM9 processors which is used to enable and 
disable interrupts within the operating system.  This code is called from C with 
OS_ENTER_CRITICAL() and OS_EXIT_CRITICAL(). 

μC/LIB Files 

\Micrium\Software\uC-LIB 

This directory contains lib_def.h, which provides #defines for useful constants (like DEF_TRUE 

and DEF_DISABLED) and macros. 

\Micrium\Software\uC-LIB\Doc 

This directory contains the documentation for μC/LIB. 

Application Code 

\Micrium\Software\EvalBoards\NXP\LPC2103-02-SK \IAR\OS-Probe 

This directory contains the soruce code the µC/OS-II and µC/Probe example application: 

 app.c contains the test code for the example application including calls to the functions 

that start multitasking within μC/OS-II, register tasks with the kernel, and update the user 

interface (the LEDs and the push buttons) 

 app_cfg.h is a configuration file specifying stack sizes and priorities for all user tasks and 
#defines for important global application constants. 

 includes.h is the master include file used by the application. 

 os_cfg.h is the μC/OS-II configuration file.  

 LPC2103-02-SK-OS-Probe -Workspace.wsp is an example µC/Probe workspace.  

 LPC2103-02-SK-OS-Probe-v5-2.* are the IAR EWARM v5.2x project files.  

 

\Micrium\Software\EvalBoards\ NXP\LPC2103-02-SK \IAR\BSP 

This directory contains the Board Support Package for the IAR LPC2103-02-SK evaluation board: 

 bsp.c contains the board support package functions which initialize critical processor 
functions (e.g., the PLL) and provide support for peripherals such as the push buttons and 
LEDs.   

 bsp.h contains prototypes for functions that may be called by the user. 

 cstartup.s is the IAR EWARM v5.2x startup file.  This file performs critical processor 
initialization (such as the initialization of task stacks), readying the platform to enter 
main(). 

 LPC2103_Flash.icf is a IAR EWARM v5.2x linker file which contains information about the 
placement of data and code segments in the processor‟s memory map.  

 LPC2103_Flash.mac contains instructions that are executed prior to loading code onto the 
processor. 
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4.  Application Code  

The example application described in this appnote, AN-1073, is a simple demonstration of μC/OS-II and 

μC/Probe for the NXP‟s LPC2103 processor on the IAR LPC2103-02-SK evaluation board.  The basic 

procedure for setting up and using each of these can be gleaned from an inspection of the application 
code contained in app.c, which should serve as a beginning template for further use of these software 
modules.  Being but a basic demonstration of software and hardware functionality, this code will make 

evident the power and convenience of μC/OS-II “The Real-Time Kernel” used on the                                  

NXP‟s LPC2103 processor without the clutter or confusion of a more complex example. 

4.01  app.c 

Five functions of interest are located in app.c: 

1. main() is the entry point for the application, as it is with most C programs.  This function 

initializes the operating system, creates the primary application task, AppTaskStart(), begins 

multitasking, and exits. 

2. App_TaskStart(), after creating the user interface tasks, enters an infinite loop in which it 

blinks the LEDs on the board. 

void  main (void)                                                /* Note 1 */ 

{ 

    CPU_INT08U  err; 

 

 

    BSP_IntDisAll();                                             /* Note 2 */ 

 

    OSInit();                                                     /* Note 3 */ 

 

    OSTaskCreateExt((void (*)(void *)) App_TaskStart,              /* Note 4 */ 

                    (void           *) 0, 

                    (OS_STK         *)&AppTaskStartStk[APP_CFG_TASK_START_STK_SIZE - 1], 

                    (INT8U           ) APP_CFG_TASK_START_PRIO, 

                    (INT16U          ) APP_CFG_TASK_START_PRIO, 

                    (OS_STK         *)&AppTaskStartStk[0], 

                    (INT32U          ) APP_CFG_TASK_START_STK_SIZE, 

                    (void           *) 0, 

                    (INT16U          )(OS_TASK_OPT_STK_CHK | OS_TASK_OPT_STK_CLR));  

#if OS_TASK_NAME_SIZE > 13                                       /* Note 5 */ 

    OSTaskNameSet(APP_CFG_TASK_START_PRIO, "Start Task", &err); 

#endif 

 

    OSStart();                                                   /* Note 6 */ 

} 

Listing 4-1, main() 

Listing 4-1, Note 1:  As with most C applications, the code starts in main(). 

Listing 4-1, Note 2: All interrupts are disabled to make sure the application does not get interrupted until it 
is fully initialized. 

Listing 4-1, Note 3: OSInit() must be called before creating a task or any other kernel object, as must 

be done with all μC/OS-II applications. 
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Listing 4-1, Note 4: At least one task must be created (in this case, using OSTaskCreateExt() to 

obtain additional information about the task).  In addition, μC/OS-II creates either one or two 

internal tasks in OSInit().  μC/OS-II always creates an idle task, OS_TaskIdle(), and will 

create a statistic task, OS_TaskStat() if you set OS_TASK_STAT_EN to 1 in os_cfg.h. 

Listing 4-1, Note 5: As of V2.6x, you can now name μC/OS-II tasks (and other kernel objects) and 

display task names at run-time or with a debugger.  In this case, the App_TaskStart() is given 

the name “Start Task”.  Because C-Spy can work with the Kernel Awareness Plug-In available 
from Micriμm, task names can be displayed during debugging. 

Listing 4-1, Note 6: Finally multitasking under μC/OS-II is started by calling OSSTart().  μC/OS-II will 

then begin executing App_TaskStart() since that is the highest-priority task created (both 

OS_TaskStat() and OS_TaskIdle() having lower priorities). 

 

 
static  void  App_TaskStart (void *p_arg) 

{ 

    CPU_INT08U  i; 

 

 

    (void)p_arg; 

 

    BSP_Init();                                                 /* Note 1 */    

 

#if (OS_TASK_STAT_EN > 0) 

    OSStatInit();                                               /* Note 2 */   

 #endif 

 

#if (APP_CFG_PROBE_COM_EN       == DEF_ENABLED) || \ 

    (APP_CFG_PROBE_OS_PLUGIN_EN == DEF_ENABLED)    

    App_ProbeInit();                                            /* Note 3 */   

#endif 

         

    App_TaskCreate();                                           /* Note 4 */  

    App_EventCreate();    

 

    BSP_LED_Off(0);          

    while (DEF_TRUE) {                                          /* Note 5 */  

        for (i = 1; i <= 16; i++) { 

             BSP_LED_Toggle(i); 

             OSTimeDlyHMSM(0, 0, 0, 100); 

        } 

 

        for (i = 1; i <= 10; i++) { 

             BSP_LED_Toggle(0); 

             OSTimeDlyHMSM(0, 0, 0, 50); 

        }         

    } 

} 

Listing 4-2, App_TaskStart() 

Listing 4-2, Note 1:  BSP_Init() initializes the Board Support Package—the I/Os, tick interrupt, etc.  

See Section 5 for details. 

Listing 4-2, Note 2:  OSStatInit() initializes μC/OS-II‟s statistic task.  This only occurs if you enable 

the statistic task by setting OS_TASK_STAT_EN to 1 in os_cfg.h.  The statistic task measures 

overall CPU usage (expressed as a percentage) and performs stack checking for all the tasks 
that have been created with OSTaskCreateExt() with the stack checking option set. 
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Listing 4-2, Note 3: App_ProbeInit() initialize µC/Probe. This function calls OSProbe_Init() 

which initializes the µC/Probe plug-in for µC/OS-II, which maintains CPU usage statistics for 

each task. ProbeCom_Init() which initializes the µC/Probe generic communication module,  

ProbeRS232_Init() which initializes the RS-232 communication module and KSD_Init() 

which initializes the IAR Kickstart kit demo (KSD) for the demo version of µC/Probe. (see AN-

9913).  After these have been initialized, the µC/Probe Windows program will be able to 

download data from the processor.  For more information, see Section 6. 

Listing 4-2, Note 4: App_TaskCreate(),App_EventCreate() Creates all the application tasks  and 

events (respectively).  

Listing 4-2, Note 9:  Any task managed by µC/OS-II must either enter an infinite loop „waiting‟ for some 

event to occur or terminate itself.  This task enters an infinite loop in which the LEDs are toggled. 

4.02  os_cfg.h 

The file os_cfg.h is used to configure µC/OS-II and defines the maximum number of tasks that your 

application can have, which services will be enabled (semaphores, mailboxes, queues, etc.), the size of 
the idle and statistic task and more.  In all, there are about 60 or so #define that you can set in this file.  

Each entry is commented and additional information about the purpose of each #define can be found in 

Jean Labrosse‟s book, µC/OS-II, The Real-Time Kernel, 2nd Edition.  os_cfg.h assumes you have 

µC/OS-II V2.83 or higher but also works with previous versions of µC/OS-II. 

 OS_APP_HOOKS_EN is set to 1 so that the cycle counters in the OS_TCBs will be maintained. 

 Task sizes for the Idle (OS_TASK_IDLE_STK_SIZE), statistics OS_TASK_STAT_STK_SIZE) and 

timer (OS_TASK_TMR_STK_SIZE) task are set to 128 OS_STK elements (each is 4 bytes) and 

thus each task stack is 512 bytes.  If you add code to the examples make sure you account for 
additional stack usage. 

 OS_DEBUG_EN is set to 1 to provide valuable information about µC/OS-II objects to IAR‟s C-Spy 

through the Kernel Awareness plug-in.  Setting OS_DEBUG_EN to 0 should some code space 

(though it will not save much).   

 OS_LOWEST_PRIO is set to 31, allowing up to 64 total tasks. 

 OS_MAX_TASKS determines the number of “application” tasks and is currently set to 10. 

  OS_TICKS_PER_SEC is set to 1000 Hz.  This value can be changed as needed and the proper 

tick rate will be adjusted in bsp.c if you change this value.  You would typically set the tick rate 

betweek 10 and 1000 Hz.  The higher the tick rate, the more overhead µC/OS-II will impose on 

the application.  However, you will have better tick granularity with a higher tick rate. 
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5.  Board Support Package (BSP) 

The Board Support Package (BSP) provides functions to encapsulate common I/O access functions and 
make porting your application code easier.  Essentially, these files are the interface between the 
application and the IAR LPC2103-02-SK evaluation board.  Though one file, bsp.c, contains some 

functions which are intended to be called directly by the user (all of which are prototyped in bsp.h), the 

other files serve the compiler (as with cstartup.). 

5.01  BSP, bsp.c and bsp.h 

The file bsp.c implements several global functions, each providing some important service, such as the 

initialization of processor functions for μC/OS-II to operate or the toggling of an LED.  Several local 

functions are defined as well to perform some atomic duty, initializing the I/O for the LED or initialize the 

µC/OS-II tick timer.  The discussion of the BSP will be limited to the discussion of the global functions 

that might be called from user code (and may be called from the example application). 

The global functions defined in bsp.c (and prototyped in bsp.h) may be roughly divided into two categories:  
critical processor initialization and  user interface services.  Three functions constitute the former: 

 BSP_Init() is called by the application code to initialize critical processor features (particularly 

the μC/OS-II tick interrupt) after multitasking has started (i.e., OS_Start() has been called).  

This function should be called before any other BSP functions are used.  See Listing 5-1 for more 
details. 

 BSP_IntDis() is called to disable an specific interrupt source. 

 BSP_IntDisAll() is called to disable all interrupts, thereby preventing any interrupts until the 

processor is ready to handle them. 

 BSP_IntEn() is called to enable a specific interrupt souce. 

 BSP_IntVectSet() is called to assign a ISR handler to a specific interrupt source. 

 BSP_CPU_ClkFreq() returns the clock frequency in Hz.   

Several functions provide access to user interface components: 

 BSP_LED_Toggle(), BSP_LED_On() and BSP_LED_Off() will toggle, turn on, and turn off 

(respectively) the LED corresponding to the ID passed as the argument  If an argument of 0 is 
provided, the appropriate action will be performed on all LEDs.  Valid IDs are 1, 2, 3 and 4 
(inclusive). 

 BSP_PB_GetStatus () returns the status of the board‟s push buttons corresponding the ID 

passed as the argument.   
 

 
 
 
 
 
 
. 
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5.02  Processor Initialization Functions 

void  BSP_Init (void) 

{ 

    MEMMAP = 1;                                                      /* Note 1 */    

 

    BSP_PLL_Init();                                                  /* Note 2 */ 

 

    BSP_VIC_Init();                                                  /* Note 3 */ 

 

    BSP_PB_Init();                                                   /* Note 4 */ 

                                      

    BSP_LED_Init();      

 

    BSP_Tmr_TickInit();                                              /* Note 5 */                           

} 

Listing 5-1, BSP_Init() 

Listing 5-1, Note 1:  MEMMAP register is set to  User Flash Mode , in this mode the  interrupt vectors are not 

re-mapped and reside in Flash. 

Listing 5-1, Note 2:  The PLL is initialized.  

Listing 5-1, Note 3:  The vectored interrupt controller  is initialized.  

Listing 5-1, Note 4:  The I/Os for the board‟s peripherals are initialized (LEDs and Push buttons).  

Listing 5-1, Note 4:  The µC/OS-II tick interrupt source is initialized. 

Listings 5-2 and 5-3 give the μC/OS-II timer tick initialization function, BSP_Tmr_TickInit(), the tick 

ISR handler, BSP_Tmr_TickISR_Handler().  These may serve as examples for initializing an interrupt 

and servicing that interrupt. 
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static  void  BSP_Tmr_TickInit (void) 

{ 

    CPU_INT32U  pclk_freq; 

    CPU_INT32U  tmr_reload; 

 

     

    BSP_IntVectSet((CPU_INT08U   )BSP_INT_ID_TMR0,                          /* Note 1 */    

                   (CPU_INT08U   )0, 

                   (CPU_INT08U   )BSP_INT_TYPE_NO_VEC_IRQ, 

                   (CPU_FNCT_VOID)BSP_Tmr_TickISR_Handler); 

 

    BSP_IntEn(BSP_INT_ID_TMR0); 

     

    pclk_freq  = BSP_CPU_PclkFreq();                                        /* Note 2 */    

    tmr_reload = pclk_freq / OS_TICKS_PER_SEC; 

 

    T0TCR      = 0;                                                         /* Note 3 */ 

    T0PC       = 0;   

    T0MR0      = tmr_reload; 

    T0MCR      = DEF_BIT_00 | DEF_BIT_01;     

    T0CCR      = 0;                           

    T0EMR      = 0;       

    T0TCR      = DEF_BIT_00;        

} 

Listing 5-2, BSP_Tmr_TickInit() 

Listing 5-2, Note 1:  The tick ISR handler is programmed into the vectored interrupt controller. 

Listing 5-2, Note 2:  The number of counts per tick is calculated 

Listing 5-2, Note 2:  The calculated re-load value is programmed into the Timer 0, the timer interrupt is 
enabled and the timer is started 

 

void  BSP_Tmr_TickISR_Handler (void) 

{ 

 

    T0IR = DEF_BIT_00;                                          /* Note 1 */                                      

 

    OSTimeTick();                                               /* Note 2 */                                     

} 

Listing 5-3, BSP_Tmr_TickISR_Handler() 

Listing 5-3, Note 1:  The timer 0 interrupt is cleared. 

Listing 5-3, Note 2:  OSTimeTick() informs μC/OS-II of the tick interrupt. 
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6.  μC/Probe 

µC/Probe is a Windows program which retrieves the values of global variables from a connected  

embedded target and displays the values in a engineer-friendly format.  To accomplish this, an ELF file, 
created by the user‟s compiler and containing the names and addresses of all the global symbols on the 

target, is monitored by µC/Probe.  The user places components (such as gauges, labels, and charts) into 

a Data Screen in a µC/Probe workspace and assigns each one of these a variable from the Symbol 

Browser, which lists all symbols from the ELF file.   The symbols associated with components placed on 
an open Data Screen will be updated after the user presses the start button (assuming the user‟s PC is 
connected to the target). 

 A small section of code resident on the target receives commands from the Windows application and 
responds to those commands.  The commands ask for a certain number of bytes located at a certain 
address, for example, “Send 16 bytes beginning at 0x0040102C”.  The Windows application, upon 
receiving the response, updates the appropriate component(s) on the screens with the new values.   

 

Figure 6-1. µC/Probe Windows Program 
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from the ELF files added 
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To use µC/Probe with the example project (or your application), do the following: 

1. Download and Install µC/Probe.  A trial version of µC/Probe can be downloaded from the 

Micriµm website at  

   http://www.micrium.com/products/probe/probe.html 

IAR Kickstart Kits Users 

If this development board is part of the IAR Kickstart Kit a demo version of µC/Probe is 

already included in the installation CD. Please refer to the application note AN-9913 for 

more details in how to use the demo version of µC/Probe with the IAR Kickstart kits.  

2. Open µC/Probe.  If the trail version was installed , open the example µC/Probe workspace for 

µC/OS-II, named OS-Probe-Workspace.wsp, which should be located in your installation directory 

at 

   /Program Files//Micrium/uC-Probe/Target/Plugins/uCOS-II/Workspace 

If the demo version was installed open the example workspace for the IAR Kickstarts kits named 
OS-Probe-Kickstart-Demo-Workspace.wsp, which should be located in your installation directory at 

                           /Micrium/Software/uC-Probe/Target/Demo/KSD/Workspace 

 

3. Connect Target to PC.  Currently, µC/Probe can use RS-232 to retrieve information from the 

target.  You should connect a RS-232 cable between your target and computer. 

4. Load Your ELF File.  The example projects included with this application note are already 
configured to output an ELF file.  (If you are using your own project, please refer to Appendix A of 

the µC/Probe user manual for directions for generating an ELF file with your compiler.) This file 

should be in  

   /<Project Directory>/<Configuration Name>/exe/ 

 where <Project Directory> is the directory in which the IAR EWARM project is located (extension 
*.ewp) and <Configuration Name> is the name of the configuration in that project which was built 
to generate the ELF file and which will be loaded onto the target.  The ELF file will be named  

  <Project Name>.elf  

in EWARM v4.4x and  

  <Project Name>.out  

in EWARM v5.xx unless you specify otherwise.  To load this ELF file, right-click on the symbol 
browser and choose “Add Symbols”. 

5. Configure the RS-232 Options.  In µC/Probe, choose the “Options” menu item on the “Tools” 

menu.  A dialog box as shown in Figure 6-2 (left) should appear.  Choose the “RS-232” radio 
button.  Next, select the “RS-232” item in the options tree, and choose the appropriate COM port 
and baud rate.  The baud rate for the projects accompanying this appnote is 115200. 

http://www.micrium.com/products/probe/probe.html
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6. Start Running.  You should now be ready to run µC/Probe.  Just press the run button ( ) to 

see the variables in the open data screens update. Figure 6-3 displays the µC/OS-II workspace 

which displays detailed information about each task‟s state. 
 

 

Figure 6.2.  µC/Probe Options 

 

 
 

Figure 6-3.  µC/Probe Run-Time:  µC/OS-II Task Information 



Licensing 

μC/OS-II is provided in source form for FREE evaluation, for educational use or for peaceful research.  If 

you plan on using μC/OS-II in a commercial product you need to contact Micriμm to properly license its 

use in your product.  We provide ALL the source code with this application note for your convenience and 

to help you experience μC/OS-II. The fact that the source is provided does NOT mean that you can use it 

without paying a licensing fee.  Please help us continue to provide the Embedded community with the 
finest software available.  Your honesty is greatly appreciated.  
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